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Welcome to Jade!
Welcome to Jade: the low-cost system for monitoring noise. Jade helps you capture noise data from a
sound level meter and then analyze the results.
To use Jade, you first use Jade’s data capture facility to record sound levels, mark noise events and
note observations. Then you use Jade’s data viewing facility to view the resulting data, zooming in and
out of the charts to view the data at different levels of detail. You can also edit your observations, and
print your charts and notes. Finally, you can include both charts and notes in a report using your
preferred word processor or export the data to a spreadsheet application.
Jade uses a standard PC sound card to receive raw data from the AC output of the sound level meter,
and works with any meter that has a conditioned AC output (that is the AC signal must be drawn after
any frequency weighting has been applied).
We believe that Jade is an extremely useful tool, but don’t just take our word for it. Why not install Jade
on your computer and see for yourself? We think you will be impressed by Jade’s features.

About this Guide
This guide will show you how easy it is to use Jade to capture and analyze environmental noise data. In
particular, this guide contains the following tutorials:
♦ How to View Data – This tutorial shows you how you use Jade to view and analyze noise data.
♦ How to Capture Data – This tutorial shows you how you can use Jade to record sound levels and
mark noise events for later analysis.
Jade is supplied with a sample file for use with Part 1 of the tutorial, so it is not essential to use Jade to
capture data first. However, we hope that you will have enough time to follow both parts of the tutorial
and experience the full potential of Jade.

Running Jade in Demonstration Mode
Normally you will need a PC sound card and a data cable to use Jade to capture data. However, a
demonstration sound card interface is provided so that you can try out a simulated data capture. This
simulates the use of a sound card, meter and calibrator by software so you do not need any hardware.
Although the data will not be real data, using the demonstration mode will show you Jade's capture
capabilities.
To use the demonstration sound card interface, you do not need to do anything special. Just follow the
instructions for performing a data capture and select one of the "Demonstration Card" interfaces.
Of course, if you do have the appropriate hardware, you can use Jade to capture real data. Jade is
supplied as a fully functioning program. There are no limitations to its use other than that you are
restricted to an evaluation period, after which you must register your copy (see below).

Free Trial Period
Jade is provided with an initial FREE trial period, during which all the features of the software are
available. You are welcome to use the software during this period for any purpose you wish, however
free technical support for unregistered copies is limited to installation problems only. The initial free trial
period is limited to the first 14 runs.
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Registering your Copy of Jade
After the trial period, you must register your copy of Jade and receive a registration key to continue
using Jade to capture data (otherwise you will only be able to simulate capture). You can register Jade
to run either as a full version with both data capture and viewing, or as a viewing-only version. You can
also register a special low-cost combination edition, that provides two licenses – one full license for your
main data capture computer (for example, a portable), and a second viewing-only license for a second
computer (for example, a desktop).
The registration key is specific to your company or organization (or to you personally if you register Jade
as an individual). You can move the software and the registration key freely from one machine to
another, but under the terms of the license you MUST use a different registration key for each computer
used simultaneously. If you wish to use Jade on more than one computer at the same time, you must
order a registration key for each computer. Once you have registered, the registration key is shown in
the About box (choose About... from the Help menu).
To register your copy of Jade:
1. In Jade, choose Order... from the Registration menu.
2. Fill in your registration details and print out the registration form. The registration process lets you
request quantity discounts and/or an educational/Not-For-Profit discount (for educational
establishments, Not-For-Profit organizations, and their members). The registration process also asks
you for your payment details (for example, your credit card number) and lets you request a proforma
invoice if necessary.
3. Send or fax the registration details, together with your purchase order, to your local supplier or
Ptolemy Services. Please do not email your credit card details.
For more information on registering Jade, choose How Do I Register Jade? from the Help menu.
If you have problems entering the registration key, one reason might be that the user name or
organization name for Jade does not match the one used to register Jade. In this case, you will need to
change the user name or organization name. See the next section for details.

Changing the User name or Organization name
You can change the user name or organization name using the Options|User Details... menu option.
Note that the organization name must match that supplied with any registration key used, otherwise
Jade will default to the unregistered mode. You can correct this by entering the correct organization or
user name again.

Cable Details
Jade 2 requires a simple cable to connect a sound level meter to the PC sound card. Essentially, this is
similar to a standard audio cable, but in some circumstances you may need a modified cable to adjust
the voltage level from your sound level meter to the correct levels for your sound card. In this case, an
ordinary audio cable may not be sufficient as the higher voltage level may damage the sound card.
Ptolemy Services offers a range of cables that are suitable for most of the common meters. These are
available from your supplier or Ptolemy Services.
Alternatively, you can make your own cable. See the Advanced Topics guide for more information. The
Jade installation program installs this guide on your computer and creates a Windows shortcut.
If you need any help obtaining a cable, please contact your supplier or Ptolemy Services.
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Technical Support
Free technical support is available from:
•

The documentation. Before doing anything else, please make sure that you have read the relevant
help topics or sections of the manuals.

•

From your dealer. Ptolemy Services has dealers and distributors for Jade in several countries. Send
an email to sales@ptolserv.com if you would like to receive details of any distributors in your
country.

•

On the Internet at http://www.ptolserv.com/support

•

By email from Ptolemy Services by email at support@ptolserv.com

•

By fax to Ptolemy Services on +44 (0) 1962 852644.

Note that if you are using an unregistered copy of Jade, free technical support is limited to installation
issues only and within 45 days from the date of installation.

Notes and Conventions
1. In this booklet, menu options are shown in the form xxx|yyy to represent the words "Choose the yyy
option from the xxx menu".
2. As with all Windows applications, use the OK/Save/Done button only when you actually want to
keep any changes. If you just want to leave a dialog, use the Cancel button.

Further Reading
The Jade installation program installs the following documentation on your computer:
•

User Guide – provides in-depth information on Jade.

•

On-line Help – Jade is provided with comprehensive on-line help.

•

Advanced Topics – provides information on the various entries in the jade.ini configuration file and
other advanced topics. It also provides details on how to make your own cable to connect your
sound level meter to your sound card.
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Lesson 1: Running Jade
À Run Jade by selecting Jade 2 from the Windows Start Menu.
You will see Jade’s initial splash screen.
This is followed by a dialog giving you the Tip Of The Day. This dialog provides useful tips that will help
you get the most out of using Jade. Please take time to read them. If you wish to know more, choose
the Tell Me More button.
À Read the tip and choose OK.
You are now running Jade.
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Lesson 2: How to View Data
This part of the tutorial will show you how to use Jade to view data in chart form, view notes and export
statistics. A sample measurement file is provided for use with this tutorial.

Viewing the Data in a Measurement
First, you will look at the data in the demonstration measurement file in chart form.
À Select Measurement|Measurements... or click on the Measurements button on the speed bar:
The Measurements dialog is displayed. This dialog consists of a list box showing all the Jade
measurements in your Jade data directory (represented by the closed folder icons). In this tutorial you
will be looking at a measurement of a noisy late-night party:
À Double-click on the "Noisy Party in Residential Area" folder. This displays two further folders: "Data"
and "Notes".
À Double-click on the "Data" folder. You will see a list of all the periods in this measurement (all except
the last are five minutes long).
Jade lets you open as many or as few periods as you wish. You can open a single period or select
several periods using the Shift key. If more than one period is selected, Jade joins the periods together
to make one larger period. Do this now:
À Hold down the Shift key and click on the first two periods, starting at 11:50 pm (or 23:50) and 11:55
pm (or 23:55). Then choose Open.
After a short delay you will then see a chart window containing the data for the first ten minutes of the
measurement with the statistics to the right.
At the bottom of the chart are several lines showing the events that were recorded during data capture.
In this case, there are three events:
Event

Description

NoNse

No Noise

Voices

People Talking

Motor

Motor Vehicles

In this measurement session, loud music was considered normal and the lack of music the exception. It
was therefore decided to use the NoNse event label to indicate the quiet periods.
The status bar at the bottom of the screen shows the time and dB level at the cursor bar. It also has a
data indicator (currently reading "Leq") to remind you that you are looking at Leq values. You will see
how to look at other types of data values later in this tutorial.

Showing and Hiding the Statistics
Jade displays the statistics for the measurement to the right of the chart. At the top are the statistics for
the entire ten minute period you opened (labeled "Period") and at the bottom are the statistics for the
visible chart (labeled "Chart"). Show the statistics for the visible chart:
À Click on the line marked Chart. The statistics for the visible chart appear.
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If the chart statistics are the same as the period statistics, the chart statistics are not shown. You can
see this for yourself by maximizing the chart window:
À Maximize the chart window using one of the standard Windows actions (for example, double-clicking
on the measurement period’s title bar or clicking on the Maximize button for the window).
À The chart statistics are removed from the window.

Changing the Trace Type
By default, Jade shows data as an Leq value. However, you can change the trace to show other types of
data values. There are four types of data traces: Leq, Lp (sound pressure level), Lpk (peak) and Ln.
Change to an Lp trace:
À Select Lp from the drop-down list box on the speed bar at the top of the main window.
Jade displays the trace as Lp values.

Zooming In and Out of the Chart
The chart is currently displayed at the top zoom level showing the whole period. Zoom in to see the
chart in more detail:
À Move the cursor bar to 11:56:20pm or 23:56:20 (that is, just to the right of the tallest noise spike)
using one of the following methods:
–

Placing the mouse pointer (shown as a cross) on the right side of the noise spike and clicking the
primary (left) button.

–

Using the right arrow key on your keyboard to move the cursor bar. You can also use the arrow
keys in combination with the Shift or Ctrl key to move the cursor between the larger grid ticks.

The time indicator on the status line should now read 11:56:20pm or 23:56:20.
À Select View|Home or click on the Home button on the speed bar:
You should now see the noise spike in more detail. In fact, it should now be obvious that the spike was
caused by people talking (as is shown by the Voices event).
The status bar now reads "Real". This zoom level view is the raw or home zoom level. This is the first
level at which you can see the data as the real data samples stored in the file, and not as averaged
values.
Note: There is no home zoom level when you choose an Ln trace. The reason for this is that Ln values
are always averaged and so no home zoom level is possible. Also, there is no home view if the
measurement period is so large that Jade has to average the data to fit it in memory.
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À Try zooming in and out of the data in the chart using to the five buttons on speed bar. You can also
use the View menu options or keyboard shortcuts. These are as summarized in the following table:
View Menu
Option

Speed Bar
Button

Key on
Keyboard

Effect

Zoom Out

Up arrow

Zoom out one zoom level

Zoom In

Down arrow

Zoom in one zoom level

Top

Page Up

Go to the top zoom level

Home

Home

Go to the home zoom level

Bottom

Page Down

Go to the bottom zoom level

Changing the Scale of the dB Axis
By default, Jade displays the meter range on the dB axis. However, you can change the scale of the dB
axis.
À Choose View|dB As Min/Max or click on the Min/Max button on the speed bar:
Jade adjusts the dB axis so that it shows only the actual range of values in the measurement. You may
find this view useful if your data does not cover the whole meter range.
À Now choose View|dB As Chart Range or click on the Chart Range button on the speed bar:
Jade adjusts the dB axis so that it shows a predefined chart display (typically the entire meter span).
You may find this view useful if you need to compare data from different ranges on the same meter.
À To change back to the meter range, choose View|dB As Range or click on the Range button on the
speed bar:

Hiding and Showing the Events
À Choose View|Hide Events or click on the Events button on the speed bar (note that this button is
currently depressed to indicate that events are shown):
Jade removes the event lines from the bottom of the chart, leaving more room to display the data.
À To see the event lines, choose View|Show Events or click on the speed bar button again.
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Printing the Chart (Optional)
Note: You will need to have a printer attached to your computer to print the chart.
À Choose Measurement|Quick Print or click on the Quick Print button on the speed bar:
Jade prints the visible chart to the printer as it is shown on the screen.
À To print longer sections of the chart (or the entire chart) you can also choose Measurement|Print...
or click on the Full Print button on the speed bar:
Note: When you print a chart, Jade prints the statistics with the char if the set of statistics is shown.
You may wish, therefore, to hide or show the statistics before printing. Also, the size of the window
determines how the chart is printed. You may wish, for example, to make the chart window longer and
thinner if you are printing on landscape paper.

Viewing the Notes for the Measurement
Now you will look at the notes for the measurement that were created during data capture.
À Either select Measurement|Measurements... or click on the Measurements button on the speed
bar.
The Measurements dialog is displayed as you left it the last time you used it.
À Scroll down the list box and find the Notes folder for the "Noisy Party in Residential Area"
measurement. This is located immediately after the Data folder and its periods.
À Double-click on the Notes folder to open it.
À Select the note labeled "Measurement Details" and choose Open. Alternatively, double-click on the
note to open it.
Jade displays the Measurement Details note. This note is automatically created by Jade and shows you
all the details recorded for the data capture.
The note is read-only so you cannot edit the text. However, you can copy the text to the clipboard. Do
this now so you can edit the text later in this tutorial:
À Choose Edit|Copy Note or click on the Copy Note button on the speed bar:
Jade copies the entire note to the clipboard.
À Close the note window.

Creating a New Note
À Select Measurement|Measurements... or click on the Measurements button on the speed bar.
À Select the open Notes folder for the " Noisy Party in Residential Area" measurement. Press the
Insert key on your keyboard.
À Type "My New Note" as the name of the note and choose OK.
Jade creates the new note and inserts it in the Notes folder.
À Open the new note.
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This note is editable. Jade displays a ruler and note button bar in the window for you to use to edit any
text. Paste in the text you copied earlier:
À Choose Edit|Paste or click on the Paste button on the speed bar:
You can now edit the note if you wish using the features common to most Windows word processors.

Exporting the Statistics
Jade lets you create a text file containing the statistics for one or more measurement periods. You can
then view the statistics in a text editor or use them in a word processed report.
À Choose Measurement|Measurements... or click on the Measurements button on the speed bar.
À Scroll down to the Data folder for the "Noisy Party in Residential Area" measurement, and click
anywhere in the folder to move the highlight.
À Choose the Select All Periods button. This is a quick way of selecting all the periods in the Data
folder. The periods will be joined together to make one large period so that you can export the
statistics for the entire measurement.
À Choose Export.
Jade closes the Measurements dialog and opens the Export Measurement Data dialog.
À Type "tut" in the File Name text box (Jade adds "00001" to the filename when it generates the file).
À Do not choose a directory. Jade will save the file in the Jade Export directory.
À Choose the "Period Summary Statistics" export format from the Export As drop-down list box.
À When you are ready, choose OK to export the statistics.
Jade creates a statistics file that contains a summary of the statistics for the entire period. You can now
view the statistics in a text editor (for example, Notepad) or word processor program. The file will be
called "tut00001.txt" and will be found in the Jade export directory (for example, c:\jade2\export).
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Lesson 3: How to Capture Data
Stop! If you are reading this on-line, please print this part of the tutorial before you go any further. You
will may not be able to switch between this document and Jade once data capture starts. Data capture is
a processor-intensive task and so Jade may not allow you to switch to other applications.
Important: If you do not have a sound card and data cable, you can still run Jade’s capture facility: just
follow the instructions for the demonstration mode in the steps on the following pages. Note that if you
use the demonstration mode, data capture is simulated so the data will not be real data. However, it
does allow you to see Jade’s capture facility in action.
Before going any further, close all open chart and note windows:
À Choose Window|Close All

Setting up your Sound Level Meter
First, you need to record the details about your sound level meter in Jade’s meter library (a special file
that holds details of all the meters used with the software). The steps below will show you how to set up
your sound level meter.
Note: You should make sure that all your sound level meters are uniquely identified in the meter library
– even if they are of the same model. The reason for this is that meters differ from each other in their
hardware characteristics. Therefore, a calibration for one meter may not be correct for another meter of
the same model.
À Choose Library|Meters... or click on the Meter Library button on the speed bar:
À Choose the New button to create a totally new meter (if your meter model is in the list of meters, you
can select the meter and choose the Copy button instead). Jade displays the Meter Details dialog.
À Type the model name in the Model text box.
À If you wish, you can type a name for the meter in the Name text box. This identifies this particular
meter. For example, you can use a departmental equipment code here.
À If you wish, you can record the meter's serial number, a useful note about the meter, and the date of
the meter's last laboratory calibration.
À Select the frequency weightings for the meter.
À Choose the Meter Ranges button. Jade displays the Ranges dialog.
Set up the first meter range (for example, the lowest meter range):
À Type the bottom of range in the Range Bottom text box.
À Type the top of range in the Range Top text box.
À If you wish, you can type a description for the range in the Description text box (for example, the
text that is printed on the meter).
À Leave the Output Offset set to the same value as the Range Bottom. This text box is provided to
solve a particular problem with a few unusual meters. If you find that readings during data capture
are consistently incorrect by a fixed offset, you may need to specify an offset here. See the User
Guide for more information.
À Leave the Chart Display settings for now.
À Leave the Smart Calibration check box checked. This means that if you choose this range for data
capture and it is not suitable for calibration, Jade automatically chooses a suitable range to calibrate
the meter.
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À If this range cannot be used for calibration, choose Never Use for Calibration. Otherwise, if this
range can be used for calibration, choose Can Use for Calibration or Default Calibration Range
as appropriate. Note that only one range can be the default calibration range.
À Choose the Add button to add the newly created range to the meter.
À Set up the next range for meter in the same way, over-typing the fields as necessary. If this range
can be used for calibration, set the calibration option to Can Use for Calibration or Default
Calibration Range (otherwise choose Never Use for Calibration). Choose the Add button to add
this range to the meter.
À Set up any remaining ranges in the same way.
À When you are ready, choose OK to return to the Meter Details dialog.
À In the Meter Details dialog, choose OK.
À Back in the Meter Library dialog, choose Done to save the meter library.

Calibrating your Sound Level Meter
Before you can use a sound level meter with Jade, you must calibrate the sound card and meter so that
Jade can match the voltage levels from the meter to the correct dB levels. In particular, the sound card’s
volume settings must be set to the best setting. Jade makes it very easy to calibrate the sound card and
meter. Note that if you are running Jade in demonstration mode, you can try out a simulated calibration.
À If you are not running in demonstration mode, make sure that your meter is attached to the sound
card by the cable.
À Either choose Measurement|Calibrate Meter... or click on the Calibration button on the speed bar:
À In the Meter Calibration dialog, select your newly created meter from the Meter list box.
Either:
À Select your calibrator from the Calibrator list box (you can choose a generic one if your calibrator
is not in the list). See the User Guide or Help for details on setting up a calibrator.
Or:
À If you are running in demonstration mode, choose any calibrator you wish.
Either:
À Select your sound card interface.
Or:
À In demonstration mode, choose one of "Demonstration Card" interfaces.
Note: If Jade detects that your sound card does not have an automatic volume control, it will not be
listed here, and you will not be able to use it to perform a stand-alone calibration. In this case, either
choose a demonstration card for a simulated calibration, or else choose Cancel and continue the tutorial
from Capturing Data on page 14 (you will be asked to use a manual volume control utility to calibrate
the meter before the data capture session).
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À Leave the Frequency Weighting as A.
À You can specify a microphone adjustment if necessary.
À When you are ready, choose OK.
À You may see a message warning you that single level calibration is not as accurate as a dual level
calibration. Choose OK.
Jade displays a summary dialog box showing the settings for the meter:
Either:
À Set up the meter using this information and choose OK.
Or:
À If you are running in demonstration mode, just choose OK.
Next you will see a message telling you to set the calibrator to its lower (or only) level and to calibrate
the meter.
Either:
À Set up your calibrator, attach it to the meter and turn it on.
À Adjust your meter to read the value given in the message box. Leave the meter and calibrator
turned on and choose OK.
Or:
À If you are running in demonstration mode, choose OK.
The Calibration dialog is displayed. Jade automatically tries each volume level on your sound card in
turn (from the lowest to the highest) to find the best settings. You do not need to do anything except wait
while the calibration takes place. You will see the Signal Level gauge (sound card volume level) change
from Under (or Low) to Over (or High) as the volume levels are tested. If you are running in
demonstration mode, the calibration is simulated.
You should see a message telling you calibration is successful and asking if you wish to view the results
of the calibration:
À Choose Yes. The Calibration summary dialog is displayed for the meter. When you are ready,
choose OK.

Capturing Data
À Either choose Measurement|Capture Data... or click on the Data Capture button on the speed bar:
The Data Capture dialog is displayed:
À The meter you chose for calibration should already be selected. If you wish, you can choose a
different frequency weighting from the Frequency Weighting drop-down list box.
À Set the Lp Time Weighting set to Fast or Slow, according to the weighting required for the
statistics. Most statistics use a Fast time weighting. However, some American statistics, such as
Losha, require a Slow time weighting.
Note: The time weighting on the meter is not used by Jade. The AC signal is drawn from the meter
before the time weighting is applied, so the meter can always be set to Fast. See "Capturing Data" in
the User Guide for more information.
À Select a meter range from the Meter Range list box.
À Leave the Recording Rate setting unchanged for now.
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À Choose the Lp chart trace in the Chart Trace drop-down list box to see Lp values during data
capture.
À Choose the Full Capture button.
À In The Full Data Capture Session dialog, type a name for the session in the Measurement Title field
(for example: "First Capture Session").
À Select the "5 Minutes" measurement profile. (A measurement profile is a time profile for a data
capture session and determines when data capture is to occur and for how long.)
À Select "Heavy Road" from the Event Bar list. (An event bar is used to mark noise events as they
occur.)
À Leave the Start option as it is.
À Select the Until Told To Stop option in the Continue group box (this causes the 5 Minutes profile to
be repeated indefinitely).
À Choose OK.
À The Notes Before Data Capture dialog is displayed. Normally, you would type any notes or
observations before data capture. For now, you can type something short, such as your name, here.
À Choose OK.
À You will see a message warning you how long you can capture data for. Choose OK.
You will be asked if you wish to perform a calibration.
Either:
À If you calibrated your meter in the previous section, answer No.
Or:
À If you did not calibrate your meter, answer Yes to calibrate your meter now.
À Follow the steps in the previous section to calibrate your meter. If you need to perform a manual
calibration you will be asked to run the volume control utility for your sound card.
A summary dialog is displayed telling you how to set up your meter.
Either:
À Set up the meter using this information. Turn it on and choose OK.
Or:
À If you are running Jade in demonstration mode, choose OK.
Jade displays a message box that counts up to the start of data capture and then, after a short pause,
data capture starts.
The capture window contains a chart that plots the data as an Lp trace. A current Lp value is also shown
in the box at the top right of the main capture window. Below this are the running statistics. These are
continually updated as data capture progresses.
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Using the Large Numeric Display
Jade lets you see the current value in a large-size numeric display:
À Either choose View|Large Numeric Display or click on the Numeric Display button on the
speedbar:
Jade displays the numeric display at the top of the capture window. This contains one or two boxes. The
large box on the right shows one or two of the running statistics. The box on the left (if present) shows
the current Lp value.
Tip: You can choose which running statistics are displayed in the numeric display by changing the data
capture options (see the User Guide or Help for details).

Resetting the Statistics
You can reset the running statistics at any time during data capture. Try resetting all the statistics now:
À Either choose Statistics|Reset All Statistics or click on the Reset All Statistics button on the
speedbar:
Jade resets all the statistics. You may see new values appear in the numeric display and in the running
statistics. Try experimenting with the other Reset… options on the Statistics menu (or the
corresponding buttons on the speed bar).
Note: Resetting the statistics affects only the running statistics calculated during data capture; the data
stored in the measurement file, and the statistics calculated when viewing a chart, are not affected.

Using the Event Bar to Mark Events
At the bottom of the main window is the Heavy Road event bar. The labeled buttons are used to mark
events. Round the edge of the event bar are shown keyboard shortcuts, for example, Alt + 4 marks the
Bus event.
Try adding some events:
À Select the "Horn" event (shortcut key: Alt + 5). After a brief pause a small gray mark appears on the
time axis below the appropriate data sample (only one data sample is marked because the Horn
event is a short, instant event).
Important: Because Jade has to process the data received from the sound card, the data does not
appear on the trace immediately. Therefore, there will be a short delay before you see an event appear
on the chart.
À Select the "Car" event (shortcut key: Alt + 1). Again, after a brief pause a gray mark appears on the
time axis. This time the mark extends along the time axis to show a continuing event.
À Select the "Car" event button again (or use the shortcut key) and the event stops.
You can overlap events if you wish: just turn the events on and off by clicking on the buttons as needed.
Try this out now. You can also use the End button to end the most important event (that is, the one
shown on the status bar). Try using the keyboard shortcuts also.
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You can hide and show the event bar:
À Choose Hide Event Bar from the System Menu or click on the Event Bar button on the speed bar:
The event bar disappears giving more room for the chart.
À To make the event bar re-appear, either choose Show Event Bar from the System Menu or click
again on the Event Bar button.

Stopping Data Capture
When you are ready, stop data capture:
À Either choose Measurement|Stop Capture or click on the Stop Capture button on the speed bar:
Jade now lets you view the final state of the chart and statistics.
When you are ready, return to normal mode:
À Choose Return To Normal from the System Menu or click on the Return button on the speed bar:
Jade displays the Notes After Data Capture dialog so you can type any additional notes. Choose OK.
Congratulations! You have now used Jade to capture data.

Exiting from Jade
You have now completed all three parts of the tutorial. The next page gives you a list of things you might
like to try out for yourself. Alternatively, you can exit from Jade:
À To exit from Jade, either choose Exit from the System Menu or type Alt + F4.
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Exploring Further
Now that you have followed the tutorials and seen some of the features that Jade offers, you will want to
try out some of Jade’s other features. The following sections contain information on some of things you
might like to try. For full details, se the User Guide or the on-line Help system.

Setting up the calibration options
You can set the calibration options. Choose Options|Calibration... or click on the Calibration Options
button on the speed bar:
In particular, try experimenting with the following:
•

Calibration Before Full/Preview Capture – specify when calibration is to be done as part of data
capture. Stand-alone calibrations are unaffected.

•

Validate Meter Accuracy After Full Data Capture – lets you validate the meter after data capture
to check if the meter readings have slipped.

Opening or Exporting Non-Standard Periods
In the Measurements dialog you can open or export a non-standard period (that is, one that is not
listed). This is useful if you wish to open the data, say, for a particular event.
To open a non-standard period:
1) Choose Measurement|Open.
2) Double-click on your measurement to open it.
3) Double-click on the Data folder to open it.
4) Leave the highlight on the Data folder and choose Open or Export.
5) In the Measurement Data Period dialog, enter or edit the start and end time for the period you wish
to open or export.
6) Choose OK.
Note: You will only be given the opportunity to specify a start and end time if the highlight is on an open
Data folder when you choose Open or Export.

Automatically Resetting Statistics
In the tutorial you were asked to manually reset the statistics during data capture. You can also ask
Jade to automatically reset the dose, Ln and other statistics at the end of each profile sampling period.
For example, if you do a 10 hour data capture using the 10 minute profile, the displayed statistics will
reset every 10 minutes.
To use this feature:
À Start a full data capture by choosing Measurements|Data Capture and then choosing the Full
Capture button.
À In the Full Data Capture Session dialog, check the "Reset Statistics Each Profile Sampling Period"
so that the check box is on.
When this feature is active, the capture statistics window has a field labeled "Period" that shows the
number of samples in the current profile period (and this will periodically reset back to zero).
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Setting up the capture options
You can set the capture options. Choose Options|Capture... or click on the Capture Options button on
the speed bar:
In particular, try experimenting with the following:
•

Automatic Event Threshold – lets you specify a threshold level above which data is automatically
marked as an Automatic Threshold event.

•

Lpk Event Threshold – lets you specify a peak level above which data is automatically marked as
an Lpk event.

Setting the statistics options
The statistics options let you choose the running statistics for data capture and the statistics shown
when you view a chart. Choose Options|Statistics... or click on the Statistics Options button on the
speed bar:

Creating a snapshot image
You can create a snapshot image of a chart image in a Windows Metafile format (WMF) file. You may
wish to use such files to include charts in a word processed report. To do this, in an open chart choose
Measurement|Snapshot Chart... or click on the Snapshot button on the speed bar:

Copying a chart image
You can copy a chart image to the clipboard and pasting it into a word processor document. This is a
quick way of importing the chart image into a word processor document. To do this, in an open chart
choose Measurement|Copy to Clipboard or click on the Copy button on the speed bar:

Exporting a note
You can export a note as a Rich Text Format (RTF) file. This preserves the text and formatting so that
you can open the file in a word processor. You do this in the Measurements dialog by selecting a note
and then choosing the Export button.

Exporting data
You can export the data from a measurement (for example, for use in a spreadsheet). You do this in the
Measurements dialog by selecting one or more periods and choosing the Export button. Then, in the
Export Measurement Data dialog, choose one of the "Data..." formats or the "Bin Counts" format.

Archiving a measurement to floppy disk
You can archive your measurements on floppy disk. This is a useful feature if you need to take regular
backups of important data files. To archive a measurement, first close all chart and note windows, and
then choose Measurement|Maintenance... or click on the Maintenance button on the speed bar:
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Getting Help
You can obtain help on using Jade in one of the following ways:
♦ Reading the User Guide.
♦ Using Jade’s help system.
♦ Reading the Tip of the Day.
♦ Choosing the Help button in a dialog.

Reading the User Guide
In addition to this Getting Started guide, Jade is supplied with a detailed User Guide. The Jade
installation program installs the User Guide in the Jade directory and creates a Windows shortcut.
You are recommended to take time to browse through the User Guide and familiarize yourself with all
Jade’s features. In particular, you should read about those features that are not fully covered in this
Getting Started guide (such as, exporting data and notes, archiving measurements and validating a
meter after capture).

Using Jade’s Help System
You can access the Help system either by using one of the commands on the Help menu or by using
the Help Contents button on the speed bar:

Tip of the Day
The Tip Of The Day is displayed when you run Jade. Once you are running Jade, you can choose
Help|Tip Of The Day… to view the tips.
It is recommended that you take the time to read the tips in order to maximize your use of Jade. For
many of the tips you can choose the Tell Me More button to read the appropriate help topic in Jade’s
help system.

Help on Dialogs
When in a dialog, choose the Help button for help on filling in the dialog fields.

Advanced Topics
The Advanced Topics guide provides information for experienced users. You may find it useful if you
wish to customize Jade or need to change some of Jade’s system settings. The Jade installation
program installs this guide in the Jade directory and creates a Windows shortcut.
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Thank you for taking the time to follow the tutorials and evaluate Jade 2. We hope that you found it an
enjoyable and useful experience. If you wish to register your copy of Jade 2, see How Do I Register
Jade? on the Help menu. If you have any further questions, please contact your supplier or Ptolemy
Services.

Copyright © 1997-2000 Ptolemy Services. All rights reserved.
Consent is hereby given to distribute this publication in its entirety in electronic form by disk, CD-ROM, public data networks including the Internet or other electronic
means as part of the unmodified Jade distribution archive. Consent is also given for the user to print one copy of this publication for personal use. In all other
circumstances, no part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical,
photocopying, recording or otherwise without the written permission of the copyright owner.
The author, suppliers and distributors endeavor to ensure that the information contained in this publication is correct, but do not accept liability for any errors or
omissions. Neither is any liability assumed for damages resulting from the use of any information contained in this publication. The development of the Jade product
line is continuous and published documentation may not be up to date. Any particular version may contain only part of the facilities described in the documentation or
may contain facilities not described in the documentation. Specifications and statements as to performance are estimates only and are not intended as a statement of
actual performance in any particular implementation.
The documentation does not form part of the license or contract save insofar as they are expressly included in any license or contract. The issue of any documentation
does not necessarily entitle the recipient to access of or use of any software or hardware described therein.
The software and hardware described in the documentation is not designed or supplied to be used in circumstances where personal injury or death or damage to
property could result from any defect or error in the software or hardware.
Unless otherwise noted, all names of companies, products, locations and persons contained herein are part of a completely fictitious scenario or scenarios and are
designed solely to document Ptolemy Services’ products.
Jade 2, ptolserv, ptolserv.com and Ptolemy Services are trademarks or Ptolemy Services.
Microsoft and MS-DOS are registered trademarks and Windows is a trademark of Microsoft Corporation.
All other trademarks acknowledged.

Page 21

